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1.  Wstęp
JTAG-lock-pick Tiny 2  to  JTAG do procesorów z rdzeniem ARM podłączany do komputera  PC 
przez magistralę USB 2.0. Urządzenie oparte jest o układ FTDI FT232H1, czyli jednokanałowy kon-
werter USB <=> UART/FIFO. Projekt JTAG-lock-pick Tiny 2  powstał z myślą stworzenia małe-
go i taniego, ale jednocześnie w pełni funkcjonalnego i szybkiego interfejsu o szerokim zastosowa-
niu.

Rys. 1: JTAG-lock-pick Tiny 2 - pcb

Dzięki wykorzystaniu magistrali USB urządzenie można podłączyć do praktycznie każdego istnieją-
cego komputera PC, co nie jest możliwe przy wykorzystaniu interfejsu równoległego (LPT), który 
odchodzi już w całkowite zapomnienie. Dzięki wykorzystaniu nowszego standardu –  USB 2.0 – 
szybkość pracy wzrasta o 30 – 270% w porównaniu do USB 1.x2.

Interfejs JTAG pozwala na osiągnięcie częstotliwości zegara do 30MHz oraz na wykorzystanie try-
bu RTCK (tzw. Adaptive Clocking, w którym dzięki sprzężeniu zwrotnemu prędkość zegara dopaso-
wuje się  dynamicznie do prędkości  układu docelowego). Dzięki zastosowaniu zaawansowanego 
układu CPLD firmy Lattice z serii ispMACH 4000ZE3 w roli układu buforującego możliwa jest ko-
munikacja z układami zasilanymi napięciami z szerokiego zakresu – od 1,4V do 3,6V. Wejścia inter-
fejsu są odporne na sygnały o napięciu wyższym niż napięcie zasilania (do 5,5V), więc możliwa jest 
również praca z układami zasilanymi napięciem  5V przy spełnieniu dodatkowych założeń  (patrz 
rozdział 2.3).

1 http://www.ftdichip.com/Products/ICs/FT232H.htm  
2 http://permalink.gmane.org/gmane.comp.debugging.openocd.devel/21828  
3 http://www.latticesemi.com/products/cpld/ispmach4000ze/index.cfm  
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Dodatkowo JTAG-lock-pick Tiny 2  wspiera komunikację z układem docelowym przez nowszy in-
terfejs SWD (Serial Wire Debug), w którym do komunikacji wystarczają tylko dwie linie – dwukie-
runkowa linia danych SWDIO oraz zegar SWCLK.

Interfejs  JTAG-lock-pick Tiny 2  można również  wykorzystać do programowania innych typów 
układów, takich jak FPGA, CPLD, AVR czy MIPS.

JTAG-lock-pick  Tiny 2  jest  częściowo kompatybilny z interfejsem  KT-LINK4 firmy  KrisTech, 
dzięki czemu w wielu aplikacjach można korzystać z gotowych ustawień konfiguracyjnych zamiast 
tworzyć je ręcznie.

Interfejs JTAG-lock-pick Tiny 2  posiada rozdzielone linie SRST i  TRST, które można dodatkowo 
niezależnie konfigurować na pracę w trybie push-pull lub open-drain.

Projekt  JTAG-lock-pick Tiny 2  jest zminiaturyzowaną  i unowocześnioną wersją projektu  JTA-
G-lock-pick 1.x.x5.

Rys. 2: JTAG-lock-pick Tiny 2

Na rysunku 1 przedstawiona jest zmontowana płytka układu JTAG-lock-pick Tiny 2 , natomiast na 
rysunkach 2 i 3 przedstawiony jest układ w pełniącej rolę obudowy przezroczystej koszulce termo-
kurczliwej.

1.1.  Obsługiwane układy
Interfejs  JTAG-lock-pick  i  obsługujące go oprogramowanie na komputer  PC (m.in.  OpenOCD, 
Atollic TrueSTUDIO, CooCox CoIDE, Keil MDK-ARM, IAR Embedded Workbench for ARM, Row-

4 http://www.shop.kristech.eu/product_info.php?products_id=257  
5 http://www.distortec.pl/jtag-lock-pick  
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ley CrossWorks for ARM, patrz rozdział 4) są w stanie komunikować się z praktycznie każdym ist-
niejącym typem procesora ARM, w tym z najpopularniejszymi:

– Cortex-M3 (STM32, LM3S, LPC17xx, AT91SAM3, …),
– ARM7 (LPC2xxx, AT91SAM7, STR7xx, ...),
– ARM9 (LPC3xxx, AT91SAM9, STR9xx, ...),
– ...

Dodatkowo interfejs  można wykorzystać  do programowania innych typów układów,  takich jak 
FPGA, CPLD, AVR czy MIPS.

Jedynym czynnikiem limitującym jest obsługa danego układu przez oprogramowanie na kompute-
rze PC.

Rys. 3: JTAG-lock-pick Tiny 2

1.2.  „Mocne strony” projektu JTAG-lock-pick Tiny 2
– magistrala USB 2.0 Hi-Speed 480Mbps,
– wsparcie dla interfejsu SWD (Serial Wire Debug),
– częstotliwość zegara JTAG do 30MHz, możliwość pracy w trybie Adaptive Clocking z wy-

korzystaniem linii RTCK,
– bezpieczna i bezproblemowa współpraca z układami docelowymi zasilanymi napięciem z 

zakresu od 1,4V do 3,6V, możliwość współpracy z sygnałami o poziomie do 5,5V, wszystkie 
sygnały buforowane przez zaawansowany układ CPLD,

– rozdzielone linie SRST i  TRST, które można dodatkowo niezależnie konfigurować na pracę 
w trybie push-pull lub open-drain,
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– całość zamknięta w „obudowie” z przezroczystej koszulki termokurczliwej, dzięki czemu 
JTAG oraz podłączony do niego komputer i układ docelowy są zabezpieczone przed przy-
padkowym uszkodzeniem,

– niewielki rozmiar całości (wymiary około 55mm x 34mm x 12mm) i niewielka cena komple-
tu,

– ...

1.3.  Zawarto ść zestawu
– debugger / programator JTAG-lock-pick Tiny 2 , lutowany maszynowo, przetestowany, za-

mknięty w „obudowie” z przezroczystej koszulki termokurczliwej (wymiary około 55mm x 
34mm x 12mm) (rysunek  1, 2 i 3),

– taśma przyłączeniowa JTAG <=> target, 20cm, (rysunek 4),
– kabel USB mini-B, czarny, 1,8m,
– płyta  DVD z instrukcją, sterownikami, kompletem przydatnych programów – darmowych 

(toolchainy  gcc:  CodeSourcery,  Linaro oraz  bleeding-edge-toolchain;  IDE Eclipse,  Ope-
nOCD,  CooCox CoIDE) i komercyjnych w wersjach testowych (Atollic TrueSTUDIO for  
STM32 Lite,  Keil  MDK-ARM +  CooCox CoMDKPlugin,  IAR Embedded Workbench for  
ARM +  CooCox CoIARPlugin,  Rowley CrossWorks for ARM) – wszystkie w najnowszych 
wersjach – oraz niezbędnymi plikami.
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2.  Hardware

2.1.  Złącze JTAG
Rozkład sygnałów w gnieździe JTAG (przedstawiony w tabeli 1) jest zgodny z tzw. „standardem”.

Tabela 1: Pinologia gniazda JTAG

JVCC – 1 2 – JVCC

nTRST – 3 4 – GND

TDI – 5 6 – GND

TMS / SWDIO – 7 8 – GND

TCK / SWCLK – 9 10 – GND

RTCK – 11 12 – GND

TDO – 13 14 – GND

nSRST – 15 16 – GND

n/c – 17 18 – GND

n/c – 19 20 – GND

Linie  JVCC są liniami zasilającymi część układu buforującego (CPLD). Na rysunku 4 pokazana 
została typowa 20-to żyłowa taśma połączeniowa.

2.2.  Diody LED
Na płytce JTAG-lock-pick Tiny 2  znajdują się cztery diody sygnalizacyjne LED. Ich znaczenie jest 
następujące:

– D_USB (zielona), przy gnieździe USB – zakończenie enumeracji urządzenia USB, poprawne 
wykrycie JTAG-lock-pick Tiny 2  przez komputer PC,

– D_JVCC (zielona), przy gnieździe  JTAG – obecność prawidłowego napięcia zasilającego 
część układu buforującego (CPLD) interfejsu JTAG (i układ docelowy),

– D_SRST (żółta), przy gnieździe JTAG na środku płytki – linia nSRST jest w stanie aktyw-
nym (niskim) – układ docelowy jest zresetowany,

– D_LED (czerwona), przy gnieździe  JTAG na środku płytki – stan tej diody kontrolowany 
jest przez aplikację komunikującą się z interfejsem, np. w przypadku OpenOCD dioda miga 
gdy interfejs jest poprawnie połączony z oprogramowaniem na komputerze PC.

2.3.  Współpraca z układami zasilanymi napi ęciem 5V
Interfejs JTAG-lock-pick Tiny 2  standardowo pozwala na współpracę z układami docelowymi za-
silanymi napięciem od 1,4V do 3,6V, jednak przy spełnieniu dodatkowych założeń i odpowiedniej 
„konfiguracji”  sprzętowej możliwa jest współpraca z sygnałami o poziomie do 5,5V, a więc z ukła-
dami docelowymi zasilanymi napięciem 5V.

Założenia te są następujące:
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1. do pinów 1 i 2 gniazda JTAG (JVCC) należy doprowadzić napięcie z zakresu 1,4V do 3,6V 
(np.  3,3V),  do tych linii absolutnie nie wolno dołączać napięcia wyższego niż  3,6V (a 
więc np. napięcia zasilającego układ docelowy równego 5V),

2. układ docelowy musi poprawnie interpretować sygnały o napięciu (JVCC – 0,4V) jako stan 
wysoki – przykładowo dla JVCC równego 3,3V napięcie na wyjściach interfejsu dla stanu 
wysokiego może wynosić od 2,9V do 3,3V, nie jest więc możliwa współpraca z układami za-
silanymi napięciem  5V określającymi minimalny poziom stanu wysokiego na  0,7 * VCC 
(3,5V) – informacje taką można znaleźć w nocie katalogowej danego układu,

3. w zależności od konfiguracji sprzętowej docelowego urządzenia użycie trybu push-pull dla 
linii nSRST i/lub nTRST może nie być możliwe, należy więc stosować tryb open-drain z do-
datkowymi rezystorami podciągającymi do napięcia zasilania układu docelowego.

Prawidłowe działanie układu w takiej sytuacji możliwe jest tylko przy spełnieniu wszystkich po-
wyższych założeń.

Rys. 4: Standardowa taśma połączeniowa JTAG
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3.  Sterowniki
Pierwsze podłączenie JTAGa do komputera zaowocuje znalezieniem nowego urządzenia USB, dla 
którego należy zainstalować wybrany sterownik. Zasadniczo dostępne są trzy opcje:

– sterowniki WinUSB,
– sterowniki libusb-win32,
– sterowniki producenta układu FT232H oparte o bibliotekę ftd2xx.

Wybór uzależniony jest  od oprogramowa-
nia, które będzie używane do  debuggowa-
nia przy użyciu  JTAG-lock-pick  Tiny 2 . 
Obecnie dostępne w internecie wersje Ope-
nOCD korzystają  z  biblioteki  libusb-1.0 
(pliki konfiguracyjne w folderze scripts/in-
terface/ftdi/) lub libftdi, (pliki konfiguracyj-
ne w folderze scripts/interface/) a więc wy-
magają  sterowników  (odpowiednio)  Wi-
nUSB lub libusb-win32 - zalecany jest wy-
bór  pierwszej  opcji  (WinUSB),  gdyż  daje 
ona wymierny wzrost prędkości działania. 
Możliwa (choć  skomplikowana)  jest  rów-
nież  samodzielna  kompilacja  OpenOCD 
tak aby wykorzystywało ono nieco szybsze 
(w  systemie  Windows)  sterowniki  ftd2xx. 
Środowisko  CooCox CoIDE oraz wtyczki 
CooCox  CoMDKPlugin (dla  Keil  MDK-
ARM)  i  CooCox  CoIARPlugin (dla  IAR 
Embedded Workbench for ARM) korzystają 
ze sterowników ftd2xx. Środowisko Rowley 
CrossWorks  for  ARM potrafi  wykorzystać 
zarówno  sterowniki  ftd2xx jak  i  libusb-
win326.

Archiwum  zawierające  wszystkie  wersje 
sterowników dla  JTAG-lock-pick  Tiny 2 
znajduje się na dołączonej do zestawu pły-
cie  DVD w  katalogu  Drivers.  Najnowsze 
wersje sterowników można znaleźć też  na 
stronie  firmy  DISTORTEC 
(www.distortec.com)  w  dziale  Download 
oraz  na  stronie  Freddiego  Chopina 
(www.freddiechopin.info) w dziale  Down-
load → Projekty → JTAG-lock-pick.

W każdym przypadku zalecana jest instalacja wybranego sterownika w trybie całkowicie manual-
nym, w którym plik sterownika jest wskazywany wprost, a nie wyszukiwany przez system opera-
cyjny – w trakcie instalacji  jest to opcja  „Nie wyszukuj, wybiorę  sterownik do zainstalowania” 
(patrz rysunek 5) w przypadku systemu Windows XP lub „Pozwól mi wybrać z listy sterowników 

6 W chwili tworzenia tego dokumentu używanie sterowników libusb-win32 z interfejsem JTAG-lock-pick Tiny 2  w 
środowisku CrossWorks (wersja 2.2.0) nie jest możliwe.

Rys. 5: Ręczna instalacja sterowników w Windows XP

Rys. 6: Ręczna instalacja sterowników w nowszych 
wersjach systemu Windows
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4.  Software
Wśród programów w których można korzystać z JTAG-lock-pick Tiny 2  znajdują się najpopular-
niejsze narzędzia dla procesorów z rdzeniem ARM, m.in.: OpenOCD, Atollic TrueSTUDIO, CooCox 
CoIDE,  Keil MDK-ARM,  IAR Embedded Workbench for ARM oraz Rowley CrossWorks for ARM. 
Korzystanie z JTAG-lock-pick Tiny 2  w tych programach zostało szczegółowo opisane w kolej-
nych podrozdziałach.

Ze strony oprogramowania JTAG-lock-pick Tiny 2  może być używany jako KrisTech KT-LINK ze 
zmienionym numerem PID urządzenia USB – 0x8220. Dzięki temu użytkowanie układu jest bardzo 
proste  – w większości  przypadków wykorzystywane oprogramowanie  będzie  posiadało gotowe 
konfiguracje dla tego JTAGa.

4.1.  OpenOCD 7

Interfejs  JTAG-lock-pick Tiny 2  jest obsługiwany przez  OpenOCD w wersji  0.6.1 i  nowsze – 
współpraca z wcześniejszymi wersjami nie jest możliwa. Dalsze przykłady będą oparte o właśnie tą 
wersję,  dla uproszczenia przykładów zamiast  pełnej  nazwy pliku wykonywalnego (np.  openoc-
d-x64-0.6.1.exe) używana jest nazwa skrócona openocd.

Dla JTAG-lock-pick Tiny 2  dostępne są gotowe pliki konfiguracyjne:

– scripts/interface/ftdi/jtag-lock-pick_tiny_2.cfg – korzystający z biblioteki  libusb-1.0 i  ste-
rownika WinUSB,

– scripts/interface/jtag-lock-pick_tiny_2.cfg –  korzystający z  biblioteki  libftdi i  sterownika 
libusb-win32.

Aby uruchomić OpenOCD z JTAG-lock-pick Tiny 2  można skorzystać z następującej komendy

openocd -f interface/ftdi/jtag-lock-pick_tiny_2.cfg  -f target/XXX.cfg
lub
openocd -f interface/ftdi/jtag-lock-pick_tiny_2.cfg  -f board/XXX.cfg
lub
openocd -f interface/jtag-lock-pick_tiny_2.cfg -f t arget/XXX.cfg
lub
openocd -f interface/jtag-lock-pick_tiny_2.cfg -f b oard/XXX.cfg

(w zależności od tego jakie zostały zainstalowane sterowniki i tego gdzie zlokalizowany jest plik 
konfiguracyjny dla docelowego urządzenia / układu).

Dla przykładu – wywołanie OpenOCD dla układu z rodziny STM32F1x (ARM Cortex-M3) przy za-
instalowanych sterownikach WinUSB:

openocd -f interface/ftdi/jtag-lock-pick_tiny_2.cfg  -f target/stm32f1x.cfg

Jeśli nie ma ku temu przeciwwskazań (takich jak np. brak fizycznego podłączenia na płytce, brak 
wsparcia w danym typie układu, …), to zawsze warto skonfigurować też używanie dwóch oddziel-
nych linii resetu. Dodatkowo zawsze należy skonfigurować prędkość JTAGa:

openocd -f … -f … -c "adapter_khz XXX; reset_config  trst_and_srst;"

gdzie XXX to częstotliwość pracy JTAGa w kHz – powinna być przynajmniej 6x, a zwykle przynaj-
mniej 8x mniejsza niż częstotliwość rdzenia po resecie – przykładowo dla STM32F1x, które po re-
secie pracują z częstotliwością 8MHz, należy użyć wartości 1000 (1MHz).

7 http://openocd.sourceforge.net/  
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Przedstawione powyżej przykładowe wywołanie powinno dać efekt zbliżony do poniższego (komu-
nikaty zależne będą oczywiście od wersji OpenOCD i używanego układu docelowego):

> openocd-x64-0.6.1.exe -f interface/ftdi/jtag-lock -pick_tiny_2.cfg -f 
target/stm32f1x.cfg -c "adapter_khz 1000; reset_con fig trst_and_srst;"
Open On-Chip Debugger 0.6.1 (2012-10-07-10:39)
Licensed under GNU GPL v2
For bug reports, read
        http://openocd.sourceforge.net/doc/doxygen/ bugs.html
Info : only one transport option; autoselect 'jtag'
adapter speed: 1000 kHz
adapter_nsrst_delay: 100
jtag_ntrst_delay: 100
cortex_m3 reset_config sysresetreq
adapter speed: 1000 kHz
trst_and_srst separate srst_gates_jtag trst_push_pu ll srst_open_drain
Info : clock speed 1000 kHz
Info : JTAG tap: stm32f1x.cpu tap/device found: 0x3 ba00477 (mfg: 0x23b, 
part: 0xba00, ver: 0x3)
Info : JTAG tap: stm32f1x.bs tap/device found: 0x16 410041 (mfg: 0x020, 
part: 0x6410, ver: 0x1)
Info : stm32f1x.cpu: hardware has 6 breakpoints, 4 watchpoints

OpenOCD można również wykorzystywać jedynie do programowania układu docelowego z linii 
poleceń (lub przy użyciu plików wsadowych / skryptów) przy użyciu komendy:

openocd -f ... -f ... -c "adapter_khz XXX; reset_co nfig trst_and_srst; 
init; reset init; flash write_image erase YYY.EXT; reset run; shutdown;"

gdzie YYY.EXT to nazwa pliku wraz z rozszerzeniem, automatycznie obsługiwane rozszerzenia to 
„elf” , „hex”  i „bin” .

Komenda ta łączy w sobie kilka poleceń OpenOCD:

– init – wymagane jest przed kolejnymi komendami „wykonywalnymi” (innymi niż konfigu-
racyjne) w linii poleceń,

– reset init – resetuje, zatrzymuje układ i przeprowadza opcjonalną inicializację – zatrzymanie 
układu jest konieczne przed jego programowaniem,

– flash write_image erase YYY.EXT – ładuje do układu zawartość z pliku YYY.EXT (gdzie EXT 
to rozszerzenie hex, bin lub elf), uprzednio kasując pamięć (jedynie strony które zostaną za-
pisane),

– reset run – resetuje i uruchamia układ, dzięki czemu startuje wgrany program,
– shutdown – zamyka sesję OpenOCD.

Przykład programowania układu  z rodziny STM32F1x plikiem stm32_blink_led.hex przedstawiony 
jest poniżej.

> openocd-x64-0.6.1.exe -f interface/ftdi/jtag-lock -pick_tiny_2.cfg -f 
target/stm32f1x.cfg -c "adapter_khz 1000; reset_con fig trst_and_srst; 
init; reset init; flash write_image erase d:/stm32_ blink_led.hex; reset 
run; shutdown;"
Open On-Chip Debugger 0.6.1 (2012-10-07-10:39)
Licensed under GNU GPL v2
For bug reports, read
        http://openocd.sourceforge.net/doc/doxygen/ bugs.html
Info : only one transport option; autoselect 'jtag'
adapter speed: 1000 kHz
adapter_nsrst_delay: 100
jtag_ntrst_delay: 100
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cortex_m3 reset_config sysresetreq
adapter speed: 1000 kHz
trst_and_srst separate srst_gates_jtag trst_push_pu ll srst_open_drain
Info : clock speed 1000 kHz
Info : JTAG tap: stm32f1x.cpu tap/device found: 0x3 ba00477 (mfg: 0x23b, 
part: 0xba00, ver: 0x3)
Info : JTAG tap: stm32f1x.bs tap/device found: 0x16 410041 (mfg: 0x020, 
part: 0x6410, ver: 0x1)
Info : stm32f1x.cpu: hardware has 6 breakpoints, 4 watchpoints
Info : JTAG tap: stm32f1x.cpu tap/device found: 0x3 ba00477 (mfg: 0x23b, 
part: 0xba00, ver: 0x3)
Info : JTAG tap: stm32f1x.bs tap/device found: 0x16 410041 (mfg: 0x020, 
part: 0x6410, ver: 0x1)
target state: halted
target halted due to debug-request, current mode: T hread
xPSR: 0x01000000 pc: 0x08000130 msp: 0x20000600
auto erase enabled
Info : device id = 0x20036410
Info : flash size = 128kbytes
wrote 22528 bytes from file d:/stm32_blink_led.hex in 1.382812s (15.910 
KiB/s)
Info : JTAG tap: stm32f1x.cpu tap/device found: 0x3 ba00477 (mfg: 0x23b, 
part: 0xba00, ver: 0x3)
Info : JTAG tap: stm32f1x.bs tap/device found: 0x16 410041 (mfg: 0x020, 
part: 0x6410, ver: 0x1)
shutdown command invoked

4.2.  Atollic TrueSTUDIO 8

W środowisku tym można korzystać z JTAG-lock-pick Tiny 2  za pośrednictwem OpenOCD (patrz 
rozdział 4.1), choć współpraca nie jest bezproblemowa. 

Przed przystąpieniem do konfiguracją należy skompilować projekt i upewnić się, że stworzony zo-
stał plik wynikowy z rozszerzeniem  .elf. W tle należy uruchomić  OpenOCD –  „zewnętrznie” (z 
wiersza poleceń systemu operacyjnego) lub konfigurując je w menu Run > External Tools > Exter-
nal Tools Configurations..., korzystając z opisu w rozdziale dotyczącym OpenOCD (patrz rozdział 
4.1).

Konfigurację  debuggowania można  przeprowadzić  za  pomocą  opcji  Debug Configurations... z 
menu Run. W nowo otwartym oknie należy stworzyć nową konfigurację typu  Embedded C/C++ 
Application i skonfigurować w odpowiedniej kolejności następujące opcje:

1. w zakładce Main w pole Project należy wpisać (lub wybrać przyciskiem Browse...) projekt 
którego dotyczyć będzie dana konfiguracja, a następnie w znajdujące się wyżej pole C/C++ 
Application należy wpisać (lub wybrać przyciskiem Search Project... lub Browse...) plik wy-
nikowy projektu z rozszerzeniem .elf; w większości przypadków pola te zostaną ustawione 
automatycznie przy tworzeniu konfiguracji;

2. w zakładce Debugger należy wybrać opcję  Connect to remote GDB server, a w pole Port  
number wpisać wartość 3333, pozostałe opcje są ignorowane – ich wartość nie ma znaczenia 
i nie należy się nimi sugerować;

3. w zakładce  Startup Debug należy usunąć  całą  zawartość pola  Initialization Commands i 
wpisać tam:

# send "reset init" to OpenOCD
monitor reset init

8 http://www.atollic.com/index.php/truestudio   



page 14/26 JTAG-lock-pick Timy 2.x.x
Manual PL 1.0 / 121227

# load application to target via GDB
load
# send "reset init" to OpenOCD
monitor reset init
# set temporary breakpoint at main() and resume tar get
tbreak main
continue

4. należy zatwierdzić wszystkie zmiany przyciskiem Apply i można od razu rozpocząć sesję 
debuggowania klikając przycisk Debug.

Problemy we współpracy pakietu  Atollic TrueSTUDIO w wersji  Lite z programem  OpenOCD to 
m.in.:

– brak możliwości  „zresetowania” układu docelowego podczas sesji  debuggowania przyci-
skiem Restart;

– komunikat  systemu operacyjnego o nieprawidłowym zamknięciu aplikacji  GDB podczas 
kończenia sesji debuggowania;

4.3.  CooCox CoIDE 9

W środowisku tym należy skorzystać z gotowej konfiguracji dla KrisTech KT-LINK. Wszelkie opcje 
konfiguracyjne dotyczące interfejsu JTAG odnaleźć można w menu Debug > Debug Configuration, 
po kliknięciu na dostępną tam konfigurację dla danego projektu (zwykle będzie to nazwa_projektu-
.configuration). Ze znajdującej się na pierwszej zakładce (Debugger) w groupboxie Hardware listy 
wyboru Adapter należy wybrać pozycję KT-Link i po kliknięciu przycisku Apply, nacisnąć przycisk 
Close.

4.4.  IAR Embedded Workbench for ARM 10

W pakiecie firmy IAR możliwe są dwa podejścia do używania interfejsu JTAG-lock-pick Tiny 2  – 
można korzystać z OpenOCD (patrz rozdział 4.1) lub z wtyczki CooCox CoIARPlugin.

4.4.1.  OpenOCD
Pierwszym krokiem jest oczywiście uruchomienie w tle OpenOCD (przez wiersz poleceń systemu 
operacyjnego) z parametrami odpowiednimi dla danego układu docelowego, korzystając z opisu w 
rozdziale dotyczącym OpenOCD (patrz rozdział 4.1).

Następnie w pakiecie IAR Embedded Workbench for ARM w opcjach projektu (Project > Options) 
należy wybrać z bocznego menu pozycję Debugger. W zakładce Setup z listy Driver należy wybrać 
pozycję  GDB Server, a w zakładce  Download zaznaczyć  opcję  Use flash loader(s). Następnie z 
bocznego menu należy wybrać pozycję GDB Server i w zakładce GDB Server w pole TCP/IP ad-
dress of hostname [.port] wpisać localhost.

4.4.2.  CooCox CoIARPlugin 11

Po instalacji wtyczki w opcjach projektu (Project > Options) należy wybrać z bocznego menu po-
zycję Debugger. W zakładce Setup z listy Driver należy wybrać pozycję RDI, a w zakładce Down-
load zaznaczyć opcję Use flash loader(s). Następnie z bocznego menu należy wybrać pozycję RDI i 

9 http://www.coocox.org/CooCox_CoIDE.htm   
10 http://www.iar.com/en/Products/IAR-Embedded-Workbench/ARM/  
11 http://www.coocox.org/CoLinkGuide/CoIARPlugin.html   
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w pole Manufacturer RDI driver wprowadzić ścieżkę do pliku CoRDI.dll znajdującego się w folde-
rze   instalacyjnym  wtyczki  CooCox  CoIARPlugin (zwykle  będzie  to  c:\Program 
Files\CooCox\CoIARPlugin\CoRDI.dll, w systemie  64-bitowym użyty będzie zwykle katalog Pro-
gram Files (x86)) oraz zaznaczyć opcję Allow hardware reset. Po zamknięciu opcji projektu przyci-
skiem OK w oknie aplikacji pojawi się nowe menu – RDI. Należy wybrać jedyną aktywną w tym 
menu opcję – Configure – i w nowo otwartym oknie wybrać z bocznej listy układ docelowy, a z li-
sty Adapter w groupboxie Adapter Config wybrać pozycję KT-Link.

4.5.  Keil MDK-ARM 12

Korzystanie z JTAG-lock-pick Tiny 2  w środowisku Keil MDK-ARM (znanym też pod nazwami 
µVision lub RealView) jest możliwe za pomocą wtyczki CooCox CoMDKPlugin13. Po zainstalowa-
niu jej, w opcjach projektu (Project > Options for Target 'nazwa_projektu', opcja dostępna tylko po 
zaznaczeniu projektu w oknie Projects) w zakładce Utilities należy z listy wyboru pod Use Target 
Driver for Flash Programming wybrać pozycję CooCox Debugger, zaznaczyć opcję Update Target  
before Debugging, a następnie nacisnąć przycisk Settings. W nowo otwartym oknie należy przejść 
do zakładki Debug i ze znajdującej się w groupboxie USB Adapter listy wyboru Adapter wybrać po-
zycję KT-Link. Po naciśnięciu przycisku OK i powrocie do opcji projektu należy przejść do zakładki 
Debug i wybrać znajdującą się po prawej stronie opcję Use, a z listy wyboru obok wybrać ponow-
nie pozycję  CooCox Debugger – nie ma potrzeby ponownego ustawiania opcji przyciskiem  Set-
tings, ponieważ są one współdzielone (zawsze takie same dla zakładki  Utilities i  Debug). Poniżej 
należy jeszcze zaznaczyć opcję Load Application at Startup oraz Run to main(). Całą konfigurację 
należy zatwierdzić przyciskiem OK.

4.6.  Rowley CrossWorks for ARM 14

Aby móc używać interfejsu JTAG-lock-pick Tiny 2  w środowisku CrossWorks należy zaimporto-
wać konfigurację interfejsu z pliku targets.xml znajdującego się w folderze Rowley CrossWorks for  
ARM/ na dołączonej do zestawu płycie DVD. Aby tego dokonać należy w dowolnym miejscu ramki 
Targets kliknąć prawym przyciskiem myszy i wybrać opcję Import Target Definitions From XML, a 
następnie wskazać plik targets.xml. Po prawidłowym dodaniu konfiguracji na liście powinna poja-
wić się pozycja DISTORTEC JTAG-lock-pick Tiny 2.

Dodatkowe opcje konfiguracyjne (interfejs  JTAG/SWD, dzielnik zegara, …) dostępne są w ramce 
Properties Window po zaznaczeniu interfejsu DISTORTEC JTAG-lock-pick Tiny 2 na liście w ramce 
Targets.

Prawidłowe połączenie z układem sygnalizowane jest na pasku statusu aplikacji oraz wyświetle-
niem numeru seryjnego interfejsu oknie  Properties Window dla wybranego interfejsu – sytuacja 
taka przedstawiona jest na rysunku 10.

12 http://www.keil.com/arm/mdk.asp  
13 http://www.coocox.org/CoLinkGuide/CoMDKPlugin.html  
14 http://www.rowley.co.uk/arm/index.htm  
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Rys. 10: Prawidłowe połączenie z układem w środowisku Rowley CrossWorks for ARM
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5.  Źródła dodatkowych informacji
Dodatkowe informacje i pomoc dotyczącą  JTAGa, oprogramowania,  debuggowania i procesorów 
ARM można znaleźć w wielu miejscach w internecie:

– strona firmy DISTORTEC ( http://www.distortec.pl/ ),
– strona Freddiego Chopina ( http://www.freddiechopin.info/ ),
– forum Elektrody ( http://www.elektroda.pl/rtvforum/ ),
– forum SparkFun ( http://forum.sparkfun.com/viewforum.php?f=18 ),
– strona OpenOCD ( http://openocd.sourceforge.net/ ),
– strona pakietu Yagarto ( http://www.yagarto.de/ ),
– strona  pakietu  WinARM (informacje  często  nieaktualne!)  (  http://www.siwawi.arubi.uni-

kl.de/avr_projects/arm_projects/ ),
– google ( http://www.google.pl/ ).
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6.  Troubleshooting
Problem: Po uruchomieniu OpenOCD pojawia się komunikat:

OpenOCD Error: unable to open ftdi device

Geneza: OpenOCD do komunikacji z układem FTDI FT232H może wykorzystywać trzy 
różne sterowniki – WinUSB, libusb-win32 lub ftd2xx. Wybór sterownika 
dokonywany jest już na etapie kompilacji OpenOCD. Komunikat taki wskazywać 
może na kilka problemów:

1. JTAG nie jest prawidłowo podłączony do komputera,
2. JTAG jest „zablokowany” przez inny program lub inną sesję OpenOCD,
3. Zainstalowane zostały niewłaściwe sterowniki do JTAGa,
4. Wybrano plik konfiguracyjny niedopasowany do zainstalowanych 

sterowników.

Rozwiązanie: Ad 1. Skontrolować połączenie JTAG <=> PC.
Ad 2. Zamknąć pozostałe sesje OpenOCD lub inne programy połączone z JTAGiem.
Ad 3. Odinstalować niewłaściwy i zainstalować właściwy sterownik (patrz rozdział 
3.4).
Ad 4. Wybrać prawidłowy plik konfiguracyjny interfejsu (patrz rozdział 4.1).

Problem: Próba programowania / debuggowania układu w pakiecie CooCox CoIDE kończy 
się błędem o treści:

Target Chip not found

Geneza: Pakiet CooCox CoIDE w wersji 1.4.0 nie współpracuje prawidłowo z JTAGami 
opartymi o układ FTDI FTx232.

Rozwiązanie: Należy użyć wcześniejszej (1.3.0) lub nowszej (1.5.0) wersji oprogramowania.

Problem: Po uruchomieniu debuggowania w środowisku CrossWorks program na długi czas 
przestaje odpowiadać lub zgłasza różne błędy.

Geneza: Choć w środowisku tym można korzystać ze sterowników libusb-win32 (w opcjach 
interfejsu opisanych jako LibUSB), to niestety z aktualną w chwili tworzenia tego 
dokumentu wersją programu (2.2.0) takie połączenie nie działa poprawnie z 
układem FT232H.

Rozwiązanie: Zainstalować sterownik ftd2xx (patrz rozdział 3.4) i skonfigurować ten sterownik w 
opcjach interfejsu (Interface > Device Driver > FTDI).
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7.  Appendix
– schemat układu (wersja 2.0.0-120820), str 20
– schemat i konfiguracja logiki CPLD (wersja 2.0.0-120820), str 22
– lista elementów (bill of materials) (wersja 2.0.0-120820), str 25
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7.1.  Schemat układu (wersja 2.0.0-120820)
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7.2.  Schemat i konfiguracja logiki CPLD (wersja 2. 0.0-120820)
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7.3.  Lista elementów (bill of materials) (wersja 2 .0.0-120820)
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